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Introduction

We are pleased to send you the release notes for Xerox® CX Print Server, Powered 
by Creo® for Xerox DocuColor® 7000AP/8000AP Digital Presses software. These 
release notes highlight the key features for the 1.0 release of CX print server 
software. Where appropriate, they refer you to the CX Print Server User Guide for 
more information. 

What is in These Release Notes
The release notes include the following sections:

Software Kit Contents—describes the contents of the CX print server software kit.

Key Features—describes new menu commands, options, windows, or dialog boxes 
that were added to the CX print server software.

Limitations—lists the limitations in this CX print server software release.
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Software Kit Contents

The software kit includes two DVDs and one CD (DVD #1, DVD #2, and CD #3). 
Each CD is described below. 

DVD #1

This DVD includes the Microsoft® Windows® XP Professional operating system 
with a customized menu for reinstalling the CX print server. 

DVD #2

This DVD contains the CX print server software (setup files, PPD files, printer 
drivers, and utilities). The CX print server was successfully tested with McAfee 
VirusScan 8.0 for Windows XP Professional server antivirus software.

CD #3

This CD contains the utilities, and the CX Print Server User Guide. 

The CD has both Macintosh® and Windows partitions and can be mounted on 
both platforms. You can copy the Xerox CX Print Server, Powered by Creo for 
Xerox DocuColor 7000AP/8000AP Digital Presses User Guide to any client 
workstation that has a CD-ROM drive and send the guides to any printer.

To print the User Guide using the CX print server software:

1. Make sure that the CX print server workspace is open; then insert CD #3 (CX 
Print Server Documentation and Utilities) into the CX print server CD-ROM 
drive.

2. From the Job menu, select Import Job.

3. Browse to the CD, and select a file.

4. In the upper list in the Import window, select the desired file(s) and click the 

add button .

The file appears on the lower side of the Import dialog box.

5. From the Virtual printer list, select ProcessPrint.

6. Click Import. 

The selected file is submitted to the CX print server to print.

Note:  This version includes Internet Explorer 6.0 and Service Pack 2.0

Note:  Make sure that the Print queue has not been stopped.
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Software Installation

For CX print server software issues, contact your customer service and technical 
support.

Key Features

This section lists features that were added to the release of CX print server software.

Hardware Components
The CX print server platform includes:

• 2 × Dual-Core Intel Xeon Processor 2GHz with 1333 MHz FSB

• 1 GB FBDIMM (Fully Buffer Dimm) Host Memory

• Creo dedicated hardware

SSC ( Signal Splitter Controller)

Fusion XM2 board with 1024 MB image memory, 1 × 512 MB (input 
memory), 2 × 256 MB (output memory)

• DVD-RW drive

• User disk:2 × 250 GB SATA2 disks as system disk

• Printer (Image) disk: 2 × 250 GB SATA2 disks as image disks

Spire Tabs Plug-In
The Spire Tabs plug-in for Acrobat (version 7.0 or later) is used to create and place 
tabs in your unprocessed (PDF or PostScript) jobs, manage the tab and text 
attributes, and save a set of attributes for future use.

When using the Spire Tabs plug-in to create tabs, it is not necessary to define 
exceptions on the Exceptions tab.

Important:  When you install the CX print server version 1.0 from DVD #1, all the files 
stored on disks C and D are deleted. Make sure to back up any important customer files 
before installing version 1.0. For more information, see the CX print server 1.0 Technical 
Manual.

Important:  If you add tabs to your job, you need to select the Mixed paper 
size document check box (in the Job Parameters window, on the Paper Stock 
tab, under Mixed paper size).
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To create tabs with the Tabs plug-in:

1. In the Storage window, right-click your unprocessed job and select 
Job Preview&Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Spire Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes tab.

On the Content tab you can select the location of the tab pages for the job as 
well as type the text that will appear on the tab itself.

The tabs that you add become part of the document.

Note:  The job must be a PDF or PostScript file.



Key Features 5

You can also manage the tabs while on the Content tab. The following actions can 
be performed:

• Remove a tab

• Change the location of a tab

• Replace a page with a tab

• Insert a tab before or after a specific page

• Delete a page or tab from the document

• Save the tab settings

• Apply saved settings to a job

• Delete saved settings

Mixed Paper Size
On the Paper Stock tab, Mixed paper size has been added to the parameters list, 
and also to the PPD file. This enables you to print a job with mixed paper sizes 
without the need for exceptions programming—for example, documents with tabs 
or manuals with folded drawings.

The CX print server automatically support mixed paper size exceptions for the 
following input files: PS, PDF, and VPS.
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Imposition Template Builder
The Imposition Template Builder enables you to create templates for similar types 
of jobs that have the following imposition settings in common:

• Imposition method

• Columns

• Rows

• Simplex/duplex

• Binding

All imposition templates are modified and managed (renamed, deleted, duplicated, 
exported or imported) through the Imposition Template Builder.

To Open the Imposition Template Builder

From the Tools menu, select Imposition Template Builder.

The Imposition Template Builder window appears.

Note:  When printing a job with mixed paper sizes from Acrobat, you must select the 
Choose Paper Source by PDF page size check box, in the Page Handling area in the 
Acrobat Print window.

Note:  The Imposition Template Builder replaces the Ultimate inSpire 
optional template builder. Therefore, custom templates created in Ultimate 
inSpire are no longer supported. These templates will need to be recreated 
using the Imposition Template Builder.
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To Create a New Template

1. From the Method list, select an imposition method.

2. Click New .

3. Type the name of the new template, and press ENTER.

4. In the Layout area, type the number of columns and number of rows that you 
need.

The imposition method that you select determines the number of columns and 
rows that you can enter. For Saddle Stitch and Perfect Bound, you can place up 
to 64 pages on one sheet (8 × 8). For Step & Repeat and Step & Continue, you 
can place up to 625 pages on one sheet (25 × 25).

5. Under Type, select Simplex or Duplex.

6. Under Orientation, select Portrait or Landscape.

7. From the Binding list, select the appropriate binding method.

8. Click Save.

All saved templates appear on the Imposition tab. After you select an imposition 
method, the related templates appear in the Template parameters, in the Layout 
list. See Table 1. For example, if you created a Step & Continue template, the 
template appears in the Layout list only when you select the Step & Continue 
imposition method. 

Some templates appear under more than one imposition method.

Note:  The Orientation setting in the Imposition Template Builder is for 
display purposes only. This parameter is not saved in the template. (You set 
job orientation on the Imposition tab, under Sizes.)

Note:  Binding is available only when Saddle Stitch and Perfect Bound 
imposition methods are selected.
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Table 1: Saved imposition templates in Layout list according to imposition method

Viewing Templates
As you create or modify a template, you can see your template in the template 
viewer. As you select parameters, the template viewer dynamically changes to 
reflect your selections.

In the template viewer, you can view the front or back pages of a template, or both 
front and back pages simulataneously.

The template viewer also enables you to rotate one or more pages and change the 
location of pages on the sheet.

Simulating Jobs With a Template
You can simulate how jobs from the Storage window will look if you apply an 
imposition template to them.

Method selected on 
Imposition tab:

Template layout type in the 
layout list:

Step & Repeat Step & Repeat, Cut & Stack

Step & Continue Step & Continue

Saddle Stitch Saddle Stitch, Perfect Bound

Perfect Bound Saddle Stitch, Perfect Bound

Notes:

• When Simplex is selected, only the Front view is available.

• Sheet size is set on the Imposition tab. The sheet size that appears in the 
template viewer is dynamic. It changes to accomodate the parameters that 
you choose.
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To simulate a job with a specific imposition template:

1. In the Imposition Template Builder window, click the Simulate button.

2. Click Browse.

The Storage window opens.

3. Select a job, and then click Select.

The parameters of the job (Sheet Size, Trim Size, Trim Orientation, Sets per 
sheet, Bleed Size, Rotate 90, Crop Marks, and Fold Marks) appear with their 
values in the Simulate Imposition window.

4. Change the parameters as desired.

Note:  Both RTP and non-RTP jobs are available for simulation.
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5. Click View Simulated Job.

The Preview window appears.

A simulation of the job is displayed with the current imposition template 
applied.

Imposition Tab
Changes have been made to the Imposition tab, which are described in the 
following sections.

Imposition Methods
The following methods have been changed or added to the Imposition method 
options:

• Step & Continue has been added to the list of Imposition method options. Step 
& Continue prints different pages of a job on one sheet so that the sheet is filled 
to capacity.

• Cut & Stack has been moved out from under the Step & Repeat method and 
can be selected on its own, independent of the Step & Repeat method. 

Cut & Stack enables jobs to be printed, cut, and stacked in the most efficient 
manner, while preserving the original sorting. A job’s pages, booklets, or books 
are sorted in a Z-shape. In other words, each stack of pages is sorted in 
consecutive order. When stacks are piled one on top of another, the entire job is 
already sorted up or down.

• sets per sheet has been added as part of the Saddle Stitch imposition method. 
When Saddle Stitch is selected, sets per sheet enables you to select how many 
sets of the job will print on one press sheet.
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Template Options
Layout options are now presented in a list. The Imposition method that you select 
determines which layouts appear in the list. There are two types of layouts:

• System layouts

The Custom option enables you to set up custom imposition parameters for 
a job. This layout is available for all imposition methods.

When the Best Fit option is selected, the server determines how many 
columns and rows will best fit the sheet and whether the pages need to be 
rotated 90 degrees according to the imposition method and paper size that 
you have chosen. The Best Fit layout is available for the Step & Repeat, Step 
& Continue, and Cut & Stack imposition methods.

• User-defined templates (created in the Imposition Template Builder)

Binding and Rotate 90 deg methods are all under Template options.

The North South check box is available when the Step & Repeat method is selected 
and the number of columns and rows is 2×1 or 1×2. Selecting the North South 
check box places pages 180 degrees from each other, on the same side of the 
imposed sheet.

The Rotate 90 deg. check box rotates all pages 90 degrees to the right. This can help 
correct imposition conflicts.

Note:  If you select Best Fit or a user-defined layout, some or all of the other 
parameters are unavailable.

Note:  The Binding option is available only when Saddle Stitch or Perfect 
Bound is selected as the Imposition method.
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Scale
Scale options have been added to the Imposition tab parameters.

• Scale by changes the scale of all imposed sheets. This is the default option, set 
to 100%. In the % box, type a value from 25% to 400% for how you want to 
change the scaling of the imposed sheets

• Fit layout to sheet size fits the page layout to the sheet size.
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The Preview Window
The Preview window enables you to view your imposition layout and settings. 

You can open the Preview window at any time and keep it open to check your 
imposition settings as you select them. The Preview window dynamically reflects 
any changes that you make.

To open the Preview window:

Click preview .

In the Preview window you can perform the following functions:

• Click Front  to view the front pages.

• Click Back  to view the back pages.

• Move between sheets by clicking the navigation arrows  .

• Jump to a specific sheet by typing a number in the navigation box.

Gray arrows indicate the direction of the pages on the sheet. The sequence of pages 
is indicated by the page numbers.

If any parameters conflict, Imposition Conflict appears in red in the Preview 
window and also on the Imposition tab.

Note:  The Preview window is not available if the Imposition method is set to 
None.
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A red border along the edge of the page indicates where the conflict exists. 

• If the red border appears along the upper and lower edges of the page, a conflict 
exists in the Height value.

• If the red border appears along the left and right edges of the page, a conflict 
exists in the Width value.

Problematic values appear in red.

Spire Print Driver Software
The CX print server Print Driver software enables you to set job parameters for jobs 
that you send to the DocuColor 8000AP Digital Press from any application on your 
client workstation. The Print Driver software also enables you to see the DocuColor 
8000AP Digital Press configuration, monitor the printer’s status, and save a set of 
print parameters for reuse.

The print driver software contains the following tabs:

• Spire Settings

• Printer

• PostScript

• About

Notes:

• The Print Driver software is only available for PC clients.

• When using the Print Driver software, ProcessStore and SpoolStore virtual 
printers are submitted as Process Print.
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Setting up the Print Driver Software
The Print Driver software is automatically installed on the client workstation when 
you set up a network printer. Once the printer is defined, you must activate the 
print driver’s enhanced user interface.

To activate the print driver’s enhanced user interface:

1. On the desktop, select Start > Settings > Printers and Faxes.

2. Right-click the printer icon and select Properties.

3. Click the Print Driver tab.

4. In the Enable enhanced user interface list, select on.

5. Click Apply.

6. Click OK to close the dialog box.

Using the Print Driver software Software
1. Open the file that you want to print—for example, a PDF file.

2. From the File menu, select Print.

3. In the Print dialog box, click Properties.

If this is the first time that you are using the Print Driver software, a message 
tells you that the software is loading. Then a dialog box appears with the print 
settings.

Note:  When printing a job from Acrobat using the Print Driver software, you must 
select the Choose Paper Source by PDF page size check box, in the Page 
Handling area in the Acrobat Print window.

Note:  The loading process might take a few minutes. Afterwards, accessing 
the print driver takes less time.
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In the print driver window, you can perform the following actions:

• Define job parameters

• Change parameters and save the settings as a profile

• Load a saved profile

• Check the status of the DocuColor 8000AP Digital Press

• Define PostScript settings for the job

Protecting Spot Colors
Using the Spot Color Editor window, you can now define specific RGB or CYMK 
colors that you want to protect—for example, official logos or company colors—to 
help produce color fidelity and color consistency between devices.

New tabs have been added to the Spot Color Editor window:

• Spot Editor

• Protect RGB

• Protect Gray

• Protect CMYK

Important:  The Protect Gray feature is included in this release but is not 
currently functional.



Key Features 17

Defining RGB and CMYK Spot Colors
When you define a specific color as an RGB or CMYK spot color, and enter a fixed 
CMYK target for it or align it to a predefined spot color, the CX print server treats 
it as a spot color, protecting it accordingly.

To define an RGB color as a spot color:

Note:  The RGB spot workflow applies only to LW elements.
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1. In the Spot Color Editor window, click the Protect RGB tab.

2. Click add .

3. In the Color name box, type a name for your color.

4. Type the RGB source values and the CMYK target values, or select a spot color 
from the Predefined Spot list.

5. Click Save.

6. On the Protect RGB tab, select the color.

The color information appears.
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7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.

A similar procedure is performed to define CMYK colors as spot colors.

Protecting Spot Colors in the Workflow
Once you have defined spot colors to protect, you need to indicate in the job 
workflow if one or more of these spot colors should be protected.

On the Color tab, under Spot workflow parameters, two check boxes have been 
added for protecting spot colors:

• Protect RGB colors: to retain RGB colors as defined

• Protect Gray colors: to retain gray colors as defined

• Protect CMYK colors: to retain CMYK colors as defined.

Note:  If you protect RGB or CMYK colors, all colors in the job with that specific 
combination will be protected. For example, a specific color combination used in 
a logo may align with a color used in an image in the job. The spot 
transformation affects the image color as well as that of the logo, sometimes to 
undesired results.
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PDF Analyzer
You can use the PDF analyzer to check imported PDF files for problems that may 
affect processing. The PDF analyzer checks the following elements:

• Document: identifies incompatibilities of Acrobat software with compression, 
encryption, security, and other properties

• Pages: detects empty pages and identifies the page size, annotations, and other 
properties

• Fonts: determines whether specific fonts are in the PDF file and whether they 
are embedded

• Colors: detects color space information, spot colors, rendering information, 
and color management settings

• Images: identifies image resolution, whether images are skewed or flipped, and 
whether images are compressed

• OPI: detects whether OPI is used. If so, the PDF analyzer detects the OPI 
version and determines whether any high-resolution images in the OPI path 
are missing

• Text and line art: identifies the size of text, the width of the lines, white text, and 
objects and flatness tolerance

• PDF/X: determines whether the file conforms to PDF/X-1a or to 
PDF/X-3 and whether the file contains PostScript fragments
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To run the PDF analyzer:

1. In the Storage folder, right-click the PDF file, and select PDF analyzer.

2. In the PDF PreFlight Settings area, do one of the following actions:

• To check the entire PDF file, select Complete Document.

• To check specific pages, select Pages and enter the desired page range.

3. If you do not want the report to automatically open when it is generated, clear 
Display report automatically.

4. If desired, change the report file name. By default, the report file name consists 
of the original file name and the suffix _rep—for example, if the file to be 
checked is sample.pdf, the report file is named sample_rep.pdf.

5. If you want to save the report to a specific location, click Browse and navigate 
to the desired location.

6. Click Run.

The PDF report is generated and opens automatically.

Default Trim Size
In the Settings window, under Preferences > General defaults, Default Image Size 
has been changed to Default Trim Size.

Print Mode
The Print Settings tab has been enhanced—Print Mode parameters have been 
added, enabling you to print color separations, progressively add color, or set up 
custom separations.

Composite
Composite prints a job without separations. Each page of the job is printed once.
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Separations
Separations prints the job with color or grayscale separations. If you select color 
separations, each page in the job is printed separately in four colors: cyan, magenta, 
yellow, and black. If you select grayscale, each page in the job is printed separately 
four times in different shades of grayscale (K).

Progressive Printing
Progressive printing prints each page of the job four times in progressive color 
separations, enabling you to examine the results of progressively adding color 
passes to a job:

• Sheet 1 is printed in cyan.

• Sheet 2 is printed in cyan and magenta.

• Sheet 3 is printed in cyan, magenta, and yellow.

• Sheet 4 is printed in cyan, magenta, yellow, and black.

Custom
Custom enables you to select the separations that you want to print for each sheet 
for each page of the job.
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Enhanced Job Info
Attributes were added to the GetFilteredJobList Spire API. These attributes enable 
the CX print server to return accounting information for jobs upon request.

The accounting information includes:

• Number of colored pages printed

• Number of black-and-white pages printed

• Duration of processing of the job

• Duration of printing of the job

Soft Proof
Soft proof enables you to preview the file—for example, in the Job Preview & 
Editor—as it should print, and add additional information on the printed sheet.

The original file gamut (CMYK/RGB) is converted to the screen RGB values using 
LAB and the data from the system monitor's ICC device profile.

The CX print server detects the monitor type and loads the profile accordingly.

Job Slug Line
The Services tab has been enhanced to include the Job slug parameter. This enables 
you to add additional information to the printed sheet, which is printed in the 
margins of a job.

The following information can be added:

• Color bar: prints a measurable color bar, enabling the user to know the state 
and consistency of the printer and calibration, and if color proofing needs to be 
performed.

• Job name

• Sheet number and side (front/back)

• Date and Time

• Comments: user can type up to 30 characters

Storage Management
In the Settings window, under Preferences, Storage Management has been added, 
enabling you to select an automatic job deletion policy for the Storage window.
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Restore Paper Sets
In the Settings window, under Administration > Configuration backup, the Paper 
Sets check box has been added to the Restore Configuration dialog box. This 
enables you to restore paper sets as part of a the restore configuration process.

New CMYK Emulation Profile
On CD #3, there is a new CMYK emulation profile, ISO_coated_sb.icc, which is 
based on the ISO ICC profile. It is located in the Utilities/Profile/Source_Profile 
folder.

Enfocus PitStop Edit Software
The Enfocus PitStop Edit software plug-in version 6.51 for Acrobat is provided in 
this release.
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Limitations

This section lists limitations new to this release of the CX print server software.

When a limitation listed here is resolved, the solution is described in the Problems 
Fixed section of the release notes for the next version of CX print server software.

Jobs with Exceptions Freezing in Print Queue
If you send a job to print that has A3 or A4 inserts that were set up as exceptions on 
the Exceptions tab, the job will freeze in the print queue. 

The following error message will appear in the Job Alerts window:

“The selected paper set in the job parameter’s window (exceptions tab) is not 
correct.”

Workaround: Go to Tools > Resource Center and select Paper Sets. Select the paper 
set name of the insert—for example, A3_Un_81-05—and click Edit. In the Paper 
Set Properties dialog box, do not make any changes. Click OK and then click Close.

In the Paper Stocks window, the status of the paper set for the insert should be 
Ready.

Mixed Paper Size
The Mixed paper size option does not work with a virtual printer that supports a 
dynamic page exceptions workflow.

Export/Print Accounting Report
To export or print all rows of an accounting report, you must first select all of the 
rows. The Print List and Export buttons are inactive until you select one or more 
rows.

Imposed VPS Jobs
If you have a custom-size job—for example, a business card—make sure to save the 
file close to the dimensions of the image. This will prevent a large trim size around 
the image when you impose the job in the CX print server. Otherwise, the job 
might not print properly.
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Huffman Compression .JPG Files
The CX print server software does not support Huffman compression .JPG files.

Printing Slip Sheets and Front and Back Covers
Slip sheets, front covers, and back covers cannot be printed if their orientation and 
page size settings are different from the job’s—for example, a letter-size slip sheet in 
an A3-size job.

PPML File Scaling
The CX print server software does not support Fit to Page scaling in PPML files.

Number of Copies in PowerPoint and Excel
When using Microsoft PowerPoint or Excel, if you choose the number of copies to be 
printed through the Spire Print Driver software, the number chosen is not reflected 
in the PowerPoint or Excel Print window.

Job Preview & Editor—Adobe Acrobat
There are two Job Preview & Editor limitations:

• When using the Job Preview & Editor to preview a PostScript or PDF file, issues 
with the workspace may occur. When prompted, download the Acrobat version 
7.0.8 update.

• DCS1 and DCS2 files that have been RIPed cannot be previewed in Acrobat 
using the Job Preview & Editor.
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Admin Page Limitation
• If you select landscape orientation and the staple option for an Admin page, the 

page is rotated and cut-off when it prints.

• In Excel files, if you select landscape orientation, the Admin page may be 
rotated and cut-off when it prints.

• In certain workflows, if the Print Method for a virtual printer is Head to Toe 
and the Job flow is ProcessStore, a blank page might print at the end of the job 
if you change the Print Method to Simplex. If this problem occurs, perform one 
of the following options:

Clear the Print Admin page check box.

Submit and process the job completely before you submit other jobs.

• In certain workflows, if you print the administration page face-up, the job may 
print as duplex (side 1 is blank and the first page of the job is printed on side 2). 
If this problem occurs, perform one of the following options:

Clear the Print Admin page check box.

Select Face down as the delivery option for the job.

VIPP Extension Limitation
If you use an incorrect file extension for a VIPP job, the job isn’t processed correctly 
and cannot print. To correct this problem, change the file extension to DBF. 

When using the VPC file format, any VIPP file extension can be used.

Remote Admin with Remote Desktop Limitation
Using Remote Admin with the Windows XP Remote Desktop Connection can 
cause the Remote Admin to not work properly— a black screen appears in the 
window of the remote tool.

Spire Job Info
For Adobe PageMaker running on Windows XP, and Microsoft Word running on 
Windows 98, the Spire Job Info fields are not supported.
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HCSS Front Staple Option Display
On the Finishing tab, under Finisher options, when you select HCSS and also select 
the Stack Tray and Stapler options, the display of the Front position for the staple is 
shown at an angle instead of straight. This is only a display issue. When the job is 
sent to the stapler finisher, the direction of the staple will be straight.

Spire Print Driver Software
There are limitations when using the Print Driver software in the following 
applications:

• Microsoft PowerPoint—for Letter or A4 paper sizes, set the paper size in 
PowerPoint. Set all other paper sizes in the PPD file.

• QuarkXPress—for Letter or A4 paper sizes, set the paper size in QuarkXPress. 
Set all other paper sizes in the PPD file.

When using the above applications, before enabling the Print Driver software, go to 
the Printer properties for the virtual printer and set the PPD page size to the 
maximum size available.

Backup and Restore Configuration
The configuration file can only be backed up to the default path, 
C:\CXP8000\General\Configuration.

If you are reinstalling the CX print server software or upgrading your CX print 
server software version, your configuration file cannot be restored using the DFE 
Configuration recovery option in Step 1 of the Configuration Wizard. 

To restore your configuration file, after the CX print server software has been 
installed, go to Tools > Settings > Administration, and select Configuration backup. 
Locate your configuration file and start the restore process.

Incorrect Print Status Information
The Printing status indicator becomes blank during a paper jam. It does not depict 
the percentage or the number of pages that have completed printing.

Note:  You can always use the PPD file instead of the Print Driver software. To use the PPD 
file, disable the Print Driver software by selecting off in the Enable enhanced user 
interface list. Refer to "Setting up the Print Driver Software"> on page 15, for more 
information.
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Job Preview & Editor—Adobe Acrobat Window in 
Background

After selecting Job Preview & Editor, the Acrobat window can switch to the 
background if the CX print server workspace is clicked as Acrobat is being 
launched. The CX print server workspace becomes the active window instead of 
Acrobat.

Press ALT+TAB to switch to Acrobat.

Simulating Jobs in the Imposition Template Builder
In this version, you can’t simulate a job in the Imposition Template Builder. Use the 
Preview window on the Imposition tab (Job Parameters window).
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